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In This Chapter:

Major Sections of a Document
Multi-Chapter Documents
Single-Chapter Documents

Style, Paragraph, and Font Issues
Word Usage
Words Not Capitalized
Indexing Guidelines
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 Chapter 1: Text
Major Sections of a Document
There are multi-chapter and single-chapter documents in Mercury IT 
Governance Center documents release 6.0.

Multi-Chapter Documents
Multi-chapter books contain the following sections, which are described in 
detail in the FrameMaker template guide:

Title page

The title pages of all books with product names in them should have the 
word “Mercury” in front of the product name.

The product names should have a TM symbol associated with them on the 
title page. This is in addition to the TM on first mention in the body of the 
text.

Copyright page

Table of contents

List of figures

List of tables

Introduction chapter, which contains the following sections:

About This Document

Who Should Read This Document

Prerequisite Documents

Related Documents

Overview of [topic] or overview of the [topic]

Use an overview section here and throughout the book where needed to 
provide relevant high-level background information.

Do not use [topic] Overview.

For More Information
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Use in this chapter and throughout the book for cross-references to 
other sections of this document and to reference other documents. Use 
the H5 (Simulated) paragraph tag to separate the references from 
surrounding text.

Begin with “For more information about [topic] see [reference].”

If this section relates to an entire chapter, include it as an H1 section 
(with similar treatment for sections below the chapter level).

Other chapters

Chapters should contain concept and task information, with only a small 
amount of reference information.

In general, chapters presented throughout the document or topics within a 
given chapter should flow:

In time sequence (for example, put tasks users will tend to do first 
ahead of tasks they will tend to do later)

In a sequence that proceeds from easy to difficult

In a sequence that proceeds from common to rare

In a sequence that proceeds from important to less important

Appendixes (if required)

Appendixes should contain either reference information or information 
used seldom or by only a small subset of users.

Appendixes in a given document would typically have little or no 
relationship to one another. Appendixes should flow:

In a sequence that proceeds from common to rare

In a sequence that proceeds from important to less important

Index

Every document should have an index. 

The indexes in documents appearing in HTML format are merged by the 
WebWorks process. Therefore, writers of those documents need to be sure 
their indexes merge gracefully.
Major Sections of a Document 7
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For general indexing guidelines, see Indexing Guidelines on page 26.

Single-Chapter Documents
Single-chapter documents include Release Notes and possible white papers. 
They use a special single-chapter FrameMaker template.
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 Chapter 1: Text
Style, Paragraph, and Font Issues
Table 1-1 lists common style, paragraph, and font issues.

Table 1-1. Style, paragraph, and font issues (page 1 of 5)

Term Usage

acronym
Spell out at first use (except common ones like SQL).
an SQL statement

active voice In general, favor active over passive voice.

address (Web)

No bold, italic, or underline.
No http:// except where you need to differentiate between 
https and http.
Use only lowercase.

bullet

Begin each bulleted item with an initial cap.
If bullets are complete sentences (in and of themselves), 
end with a period.
If bullets are incomplete sentences, don’t end with a period.
Alternate Bullet and BulletHollow for multi-level entries.
The top-level entry should always be Bullet or Step — never 
BulletHollow.
Bulleted items followed immediately by text should be bold 
and followed by a period.

button

For example, Submit button. Use the Button/Menu/Tab font 
style.
Use the term on first mention for clarification; you don’t need 
to use button thereafter. For example, “At the top of the 
menu bar is the Expand All button. Clicking Expand All 
displays all submenus . . .” 
You don’t need to use button if the context is clear; for 
example, “Click Done.” 

callout
Cross-reference located in the text preceding a figure or 
table that introduces it. See figure title.
Label identifying elements in a figure. See figure label.
Style, Paragraph, and Font Issues 9
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capitalization

Use standard heading capitalization for headings (that is, 
capitalize every word, with a few exceptions)
Capitalize the second word in a hyphenated term (for 
example, “Single Sign-On”)
Do not capitalize file names in headings (for example, 
server.conf file)
Capitalize pronouns in headings (for example, Its)
Use sentence-style capitalization for figure and table titles
Do not capitalize file names in figure and table titles, even if 
they are the first word
Capitalize entity names but not entity types for Mercury IT 
Governance Center entities. For example, “Workflow Detail 
report”

Caution box Do not use; use a Warning box.

code paragraph style Insert a blank line before one or more lines of code.

continuation variable 

Put a continuation variable in the title of every table, 
regardless of whether or not it requires one at the time it 
gets created.
If the table grows to more than two pages, use the “page x of 
y” style.

Courier Use this font for command and file names. (the Code font in the 
font catalog.)

Definition box Do not use; use a Note box.

em-dash
Close on either side.
For example, “This is a new feature—added in release 6.0.”

en-dash
Close on either side.
<<Needs an example.>>

Example box Do not use; use either Note or a longer example starting with 
an H5 (Simulated) titled Example.

figure label <<How are we doing these? I don’t see the paragraph tag.>>

figure title

Always include a cross-reference in the text preceding a 
figure. If the figure is on the same page, don’t include a page 
number. Page numbers for figures not on the same page are 
optional, unless the reference and figure are separated by 
several pages or more.
Don’t use a figure title for a figure within a procedure.
Use sentence-style capitalization.

Table 1-1. Style, paragraph, and font issues (page 2 of 5)

Term Usage
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hyphen
Close on either side. 
For example, “The range is 1-50.”

hyphenation Avoid. Never hyphenate product names.

icon

Always use the word icon after the UI item you’re identifying; 
for example, “Click the Portlet Help icon to view help about 
the portlet you’re using.” Use the Button/Menu/Tab font 
style.
Example: Environments icon (Workbench interface).
Do not use this term for a button with text (use button 
instead).
Do not include icons in inline text. Use sparingly. If you need 
to show an icon, put it into an anchored frame.

italic

Use this font for book names. (Italic in the font catalog.)
Do not use the first time a new term appears.
Use for emphasis (for example, “I’m talking about the word 
text, not test.”)
Links are in blue italic.

Key Concepts
Do not include a section of this name (use Overview, 
instead).
Point to the Key Concepts book as a prerequisite.

Mercury Support
Use the following URL:
http://support.mercury.com

navigational sequence
Use a single greater-than symbol (>); for example, Create > 
Package.
Note that the greater-than symbol is not bold.

note to reviewers

Use <<note>> for notes to reviewers during the book review 
cycle. Be sure to remove the brackets before the book goes 
to production.
You can also use AuthNote or SMENote paragraphs

Note box
Use this and Warning box.
Do not use Caution, Definition, Example, or Tip boxes.

Table 1-1. Style, paragraph, and font issues (page 3 of 5)

Term Usage
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numerals

Spell out zero through nine.
Spell out percent in all references in text.
Use Q3 2004 or Q3’04.
In phone numbers, start with the country code. Put 
parentheses around the area code and dashes (hyphens) in 
the main number. For example, 1 (800) 343-4400.

punctuation

No spaces before or after hyphens (no hyphens with -ly 
adverbs, no hyphens with most prefixes).
No spaces with -en dashes (for example, 4-6 months).
Spaces with -em dashes (for example, word1 — word2).
Use serial commas before concluding conjunctions (for 
example, apples, bananas, and pears)
Use US style for quotation marks and punctuation (for 
example, period inside quotation marks).

quotation marks

Use curly quotes in text.
Use straight quotes only in Courier (Code) examples.
Don’t put common phrases in quotation marks (for example, 
voted best-in-class, Mercury IT Governance Center . . .).

sheet x of y table continuation variable See continuation variable.

signs and symbols Don’t use the ampersand symbol (&) except in proper names 
that have it.

table title

Always include a cross-reference in the text preceding a 
table. If the table is on the same page, don’t reference a 
page number. Page numbers for tables not on the same 
page are optional, unless the reference and figure are 
separated by several pages or more.
Don’t use a table title for a table within a procedure.
Use sentence-style capitalization.

Tip box Do not use; use Note box.

Table 1-1. Style, paragraph, and font issues (page 4 of 5)

Term Usage
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trademark

Include the trademark symbol with Mercury™ at first usage.
Include the trademark symbol with the “Center” or product 
name at first usage in a given document (for example, 
Mercury IT Governance Center™ or Mercury Change 
Management™).
The only registered Mercury products are LoadRunner®, 
WinRunner®, TestDirector®, and SiteScope®. Include the 
mark at first usage.
For third-party products, include the registered mark only for 
companies with which we have a legal commitment to do so 
(SAP is one of those companies).
For an official product names list, with trademark information 
for IT Governance Center products, see the file Product-
ServicesNames_Master_October_FINAL.xls in the 
Documentation section of sharedITG.

Warning box
Use this and Note box.
Do not use Caution, Definition, Example, or Tip boxes.

we (the “royal we”) Do not say “We recommend that customers . . .” Instead, say 
“Mercury recommends that customers . . “

widows and orphans Insert manual page breaks, if necessary, to avoid bad page 
breaks.

word wraps, line breaks, page breaks
Avoid breaking Mercury Interactive and product names.
Never hyphenate product names.

Table 1-1. Style, paragraph, and font issues (page 5 of 5)

Term Usage
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Word Usage
Table 1-2 lists common word usage issues.

Table 1-2. Word usage (page 1 of 7)

Term Usage

activate Do not use. Use enable.

Adobe Reader Use this for the product with which customers view our PDF 
documents. Do not use Adobe Acrobat.

appear Dialog boxes open and close, not appear and disappear. 
Pages appear and disappear.

application
The key products that are part of Mercury IT Governance 
Center (for example, Mercury Change Management, Mercury 
Portfolio Management).

as is, as-is
Adverb: as is
Adjective: as-is

auto-populate Hyphenate.

auto-complete Hyphenate.

bash (bash shell) Use this. Note capitalization.

before No not use in a phrase like Oracle 9i or before. Use Oracle 9i or 
earlier, instead.

book Avoid; use document when referring to items in our 
documentation set.

Bourne shell Use this. Note capitalization.

cancelling
Note spelling. Approved gerund.
Approved spelling might change to canceling for the 7.0 
release.

Caution Do not use as a synonym for Warning.

check Don’t use when you mean the action of clicking a checkbox to 
select an option.

checkbox Note one word.

check in, check-in
Verb: check in
Adjective: check-in

check out, check-out
Verb: check out
Adjective: check-out
14 Documentation Style and Process Guide
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child Used to describe a parent-child relationship. Avoid elsewhere.

choose Use only when documenting generic procedures — not mouse 
procedures.

click, click in

Describes the action of positioning the pointer on a button or 
icon and then pressing and releasing the mouse button. You 
click a button or icon. You click in a window or field. You click a 
link or hyperlink.

click on Don’t use; use click.

close Dialog boxes open and close, not appear and disappear. 
Pages appear and disappear.

collapse You expand/collapse the branch in the tree hierarchy.

Dashboard Note uppercase. Always capitalize when referring to Mercury 
IT Governance Dashboard. Try to avoid using by itself.

database Note one word.

deactivate Do not use. Use disable.

deselect Use when you mean cancel a selection.

disable Use this, not turn off or deactivate.

disappear Dialog boxes open and close, not appear and disappear. 
Pages appear and disappear.

document Use to refer to the items in the product information set.

document management module

Functionality produced by EMC/Documentum and provided (at 
no extra cost) in Mercury IT Governance Center.
“Document management module” is preferred over “document 
management.” For example, “the Mercury document 
management module allows customers to . . .”

Documentation home page

Officially known as Mercury IT Governance Center 
Documentation home page
Note no italics
Note capitalization
Do not capitalize documentation by itself

double-click Note hyphenation.

download center Always use “Mercury IT Governance Download Center” (note 
capitalization).

drop-down Hyphenate. For example, drop-down list.

Table 1-2. Word usage (page 2 of 7)

Term Usage
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download Verb, noun, and adjective.

e.g. (not eg. or eg) Do not use; use for example.

earlier Use in a phrase like Oracle 9i or earlier.

easy, easily
Avoid these words and synonyms for legal reasons (for 
example, “this new release 6.0 feature allows users to easily 
run reports . . .”).

email Use this, not e-mail.

enable Use this, not turn on or activate.

end user, end-user
Noun: end user
Adjective: end-user

ensure
Avoid this word and synonyms for legal reasons (for example, 
“this functionality ensures that the Mercury IT Governance 
Server will . . “).

entity Use as a generic term for packages, object types, reports, 
requests, etc.

etc or etc. Do not use. Use and so forth.

expand You expand/collapse the branch in the tree hierarchy.

Extension Use uppercase when referring to one of the Mercury Change 
Management Extensions.

help, online help

Do not use except to refer to portlet help or general assistance. 
Use HTML document or Mercury IT Governance Center 
Documentation (the latter if you are referring to the complete 
documentation set). Italics for emphasis only.

higher No not use in a phrase like Oracle 9i or higher. Use Oracle 9i or 
later, instead.

hostname One word.

hyperlink, link You click a link or hyperlink.

HTML start page
The first WebWorks page
Note capitalization
Note no italics

Table 1-2. Word usage (page 3 of 7)

Term Usage
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icon

Always use the word icon after the UI item you’re identifying; 
for example, “Click the Portlet Help icon to view help about 
the portlet you’re using.” Use the Button/Menu/Tab font 
style.
Example: Environments icon (Workbench interface).
Do not use this term for a button with text (use button 
instead).
Do not include icons in inline text. Use sparingly. If you need 
to show an icon, put it into an anchored frame.

i.e. (not ie. or ie) Do not use; use that is.

immediately Avoid this word and synonyms for legal reasons (for example, 
“the window immediately opens”).

instance Single installation of an application or database.

Internet Capitalize.

intranet Do not capitalize.

ITG Do not use except for interface labels and objects appearing 
within Mercury IT Governance Center.

Key Concepts
Do not include a section of this name (use Overview).
Point to the Key Concepts document as a prerequisite.

later Use in a phrase like Oracle 9i or later.

link, hyperlink You click a link or hyperlink.

log off, logoff Use this. Two words when a verb. One word when a noun. Do 
not use variations of log out or sign out.

log on, logon Use this. Two words when a verb. One word when a noun. Do 
not use variations of log in or sign in.

Library Do not use; use Mercury IT Governance Center 
Documentation. Italics for emphasis only.

lower No not use in a phrase like Oracle 9i or lower. Use Oracle 9i or 
earlier, instead.

Mercury, Mercury Interactive Use Mercury Interactive only at first use (in our books, this is on 
our copyright page). Thereafter, use Mercury.

Mercury IT Governance Center Always use this, not Mercury ITG.

Mercury IT Governance Dashboard
Use this. Always capitalize Dashboard, even when it is used by 
itself. Do not include Center. You can shorten it to the 
Dashboard (note capitalization).

Table 1-2. Word usage (page 4 of 7)

Term Usage
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Mercury IT Governance Center 
database Use this. Note the word Center.

Mercury IT Governance Center 
Documentation Use this instead of Mercury IT Governance Center Library.

Mercury IT Governance Center 
standard interface Use this.

Mercury IT Governance Workbench
Use this. Always capitalize Workbench, even when it it used by 
itself. Do not include Center. You can shorten it to the 
Workbench (note capitalization).

Mercury IT Governance Center 
Workbench interface Use this.

Mercury IT Governance Server Use this. Do not include the word Center before Server.

Mercury-supplied entity Use this, not seeded.

Migrator

Use uppercase when referring to Mercury Object Migrator or 
Mercury GL Migrator.
Use lowercase when referring to an entity migrator or instance 
migrator or a migration process in Mercury IT Governance 
Center.

MS Do not use as an abbreviation for Microsoft.

multithreaded No hyphen.

newer Do not use in a phrase like Oracle 9i or newer. Use Oracle 9i or 
later, instead.

older Do not use in a phrase like Oracle 9i or older. Use Oracle 9i or 
earlier, instead.

online help, help
Do not use. Use HTML document.
See also help.

open Dialog boxes open and close, not appear and disappear. 
Pages appear and disappear.

page
The right-hand panel of the standard interface (but not the 
Workbench interface). Synonymous with Dashboard page. See 
also screen and window.

parent Used to describe a parent-child relationship. Avoid elsewhere.

pop-up (noun), pop up (verb) Use this.

portlet Lowercase.

Table 1-2. Word usage (page 5 of 7)

Term Usage
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prerequisite [document] Do not use (use related).

press You press (not hit) keys on the keyboard.

preventing Do not use.

products Use as a collective term for the applications, components, etc. 
that are part of Mercury IT Governance Center.

right-click Verb (do not use as a noun).

roll up, roll-up
Verb: roll up
Noun or adjective: roll-up

screen, screen group, screen icon

The right-hand panel of the Workbench interface. Each screen 
is part of a screen group. For example, the Package screen 
(better to call this the Package Workbench — see below) is 
part of the Demand Mgmt screen group. A screen icon is a 
graphic in the menu bar of the Workbench interface. For 
example, “To open the Packages Workbench, click the 
Packages screen icon.”
The “vanilla” Reports screen should be called the Reports 
Workbench.
Windows that open on top of a “vanilla” Workbench screen are 
windows, not pages or screens.
See also page and window.

seeded entity Do not use. Use Mercury-supplied entity.

select You select (not check) a checkbox.

server, Server

Always capitalize in Mercury IT Governance Server (note 
Server and not Center Server)
Never capitalize by itself (for example, “to start the server” 
— referring to the Mercury IT Governance Server)
Never capitalize when you are referring to Web server or 
server machine

setting, setting up Configuring is preferred.

simple, simply Avoid these words and synonyms for legal reasons (for 
example, “running reports in release 6.0 is very simple”).

subtab
A tab below another tab in a navigation hierarchy.
For example, “in the x tab, click the y subtab.”

tablespace Note one word. User table space only when referring directly to 
an item in the interface that is spelled that way.

Table 1-2. Word usage (page 6 of 7)

Term Usage
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third party, third-party

Noun: third party
Adjective: third-party
Do not use 3rd party or 3rd-party
Avoid using; use the name of the specific vendor or supplier, 
if possible

time sheet Two words.

toolbar One word.

turn off Do not use. Use disable.

turn on Do not use. Use enable.

type Use this, not enter when instructing a user to fill in a field. For 
example, “type the name of the server into the text box.”

user, user ID, user name Use this. Note capitalization.

using Use only if precisely defined.

Web, Web server Capitalize Web.

window

Valid term for both the standard and Workbench interfaces.
Windows “float” on top of pages, screens, or other windows.
When minimized, open windows appear at the bottom of the 
Workbench screen.
See also screen and page.

wizard Do not capitalize. Use when describing the wizards in the 
product set. Don’t use as a synonym for tool.

Workbench Always capitalize when referring to the Mercury IT Governance 
Workbench. Don’t overuse the word by itself.

Table 1-2. Word usage (page 7 of 7)

Term Usage
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Words Not Capitalized
The following entity names should not be capitalized (this list may not be 
complete):

access grant

action item

activity

actual

application code

asset

asset class

assignment

auto-complete list

booking

budget

business objective

business unit

calendar

charge code

command (or special command)

command step

communication plan

contact

currency

data mask

database link

directory

distribution

drop-down list
Words Not Capitalized 21



 Chapter 1: Text
entity

environment, environment group

exception

execution log

field, field group, field logic, field notification, field security

file

file system

filter criteria

instance

interface

issue

layout

license

license key

log

menu, menu bar, menu item

migrator (except for Mercury Object Migrator or Mercury GL Migrator)

milestone

module

multicurrency

navigation path

non-workload item

notification, notification engine, notification template

object, object type, object type command

open interface

organization unit

override rule

ownership
22 Documentation Style and Process Guide
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package, package process, package line, package workflow

page

parameter

participant

password

patch

period, period type

permission

personalization

polling

portfolio

portlet, portlet help

product enhancement request

product screen security

program

project

proposal

rate

reference

release (it’s also release 6.0)

release manager

report

request

resource

result

risk

run group

scheduling engine
Words Not Capitalized 23
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scope change

screen, screen group

search

security, security group

server (for Web server and server (by itself, for Mercury IT Governance 
Server)

single sign-on software

skill, skill rate

software deployment

special command, command

staffing profile

status dependency

submenu

subproject

subworkflow

summary condition

system, system requirements

table component, table rule

task

template

time

timeout

time sheet (two words)

token, token builder

transition

trigger

upgrade

user, user account, user access, user data type
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validation

window

work allocation, work item

workflow, workflow engine, workflow parameter, workflow step, 
workflow step security, workflow step source

workload item
Words Not Capitalized 25
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Indexing Guidelines

Placement

Place index markers at the end of headings, figure titles, and table titles (that is, 
after the last letter). This is to avoid having cross-reference and index markers 
stacked at the beginning of the heading.

For individual words or short phrases in paragraphs and notes, place the index 
marker at the beginning of the word or phrase (with no space between the 
marker and the first letter of the word).

Consistency of Style

Use a consistent style so entries consolidate properly. This is especially 
important for the documents appearing in HTML format (whose indexes are 
merged).

Case

Index entries should be in lowercase unless they are proper nouns.

Use of See and See Also

The words see and see also always appear in italics except when followed by a 
document title or another word in italics; in those situations, use body font for 
see and see also. For example, “see request type” and “see also Guide to 
Documentation.”

If see and see also includes a generic reference (that is, a reference to a type of 
heading rather than a specific heading), the complete cross reference is 
italicized. For example, “see also under specific release 6.0 document titles.”

List of Approved Gerunds

Use gerunds, not infinitives or commands, for task entries (for example, use 
deleting, not delete).

The following gerunds are approved (others may also be acceptable):

accessing

adding

analyzing (demand)
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applying (patches)

approving

assigning

attaching

automating

backing up

booking

browsing

cancelling (note spelling)

changing

cloning

closing

collapsing (menus)

configuring 

controlling (access)

converting

copying

creating

customizing

defining

deleting

distributing (modules)

downloading

editing

expanding (menus)

freezing (time sheets)

importing

installing
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integrating

logging

logging off

logging on

managing

merging (patches)

migrating

modifying

moving

opening

personalizing

preparing (for installation or upgrade)

printing

processing

publishing

releasing (time sheets)

renaming

requesting

reviewing

running

scheduling

searching

selecting

setting or setting up (configuring is preferred)

submitting

tracking

updating

upgrading
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using (use only if precisely defined)

validating

viewing

For More Information

For more detailed guidelines for producing indexes, see Seth Maitlin’s STC 
presentation described in For More Information on page 30.
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For More Information
Referenced and related documents:

A Brief, Comprehensive Indexing Primer, An STC Web Seminar presented 
by Seth Maislin on October 20, 2004

Key Concepts

Mercury Brand, Voice, and Editorial Style Guide, April 2004

Oracle Applications Concepts (Part No. B10642-01), May 2003

Useful for writers working on Oracle-related documents.

Industry-standard style guides:

Chicago Manual of Style, University of Chicago Press, Chicago

Webster’s New World College Dictionary (Fourth Edition), Wiley 
Publishing, Inc., 2002
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Documentation Artwork

In This Chapter:

Overview
Screenshots
Graphics

Taking Your Screenshots
Capturing the Dashboard
Capturing the Workbench

Visio Tips and Tricks
Working with Artwork in FrameMaker

Importing Your Artwork
Annotating Your Screenshots
Verifying the Formatting
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Overview
Within the framework of this discussion, artwork consists of:

Screenshots. These are snapshots of the information displayed on a user’s 
monitor when using Mercury IT Governance Center.

Graphics. These are diagrams (illustrations) created using Visio. For 
example, block or process diagrams.

Any other types of visual aids (BMP, WMF, photographs, etc.) will be 
addressed on a case-by-case basis.

Screenshots
Use the following settings for screenshots:

Capture using HyperSnap, version 3.0. (An upgrade to version 5.0 is 
pending.)

Capture on the Technical Documentation Production Lab system currently 
located in the cubicle next to Steve.

Use a resolution of 96 dpi.

Crop using HyperSnap.

Resize (scale) using FrameMaker.

Don’t use a width less than 97 pixels unless for icons, buttons, or similar 
Windows elements.

Save as GIF files in the appropriate art folder:

Use the following maximum dimensions:

Width: 5.25 inches (1024 pixels)

Height: 8.0 inches (1560 pixels)

Remember that you may want to include annotations that appear outside of the 
screenshot and this must be considered as part of the overall size.
However, this does not affect the capture phase of this process—this impacts the 
phase when you import the screenshot into FrameMaker.
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Graphics

To create graphics:

Create (and maintain) using Visio 2002.

Use a resolution of 96 dpi.

Use the following maximum dimensions:

Width: 5.25 inches (504 pixels)

Height: 8.0 inches (768 pixels)

Make graphics as large as possible while fitting in these dimensions and 
providing a pleasing design.

Use the ITG custom colors corresponding to those defined in the 
FrameMaker color map.

These are the same as detailed in the corporate branding guidelines 
available on Mindshare with the exception of itg_Crimson_Light, which is 
specific to our documentation. See Table 2-1 and Figure 2-1 for details.

Save in the following formats in the appropriate art folder:

Visio

GIF

Although the following is highly desirable, it may not be entirely feasible for the 
version 6.0 release.

If you don’t have Visio already installed, Visio can be installed, over the network, from 
the following shared drive. The license key is available in that same folder.
\\world\MVPUBLIC-SW-INSTALL\Install_IT\MS_Visio_2002
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Figure 2-1. Color samples

Table 2-1. Color map

Color Name RGB Value Visio Color

itg_Crimson 142R/0G/29B 8

itg_Crimson_Light 145R/0G/0B 9

itg_Orange 254R/166G/65B 10

itg_Medium_Gray 145R/143G/144B 11

itg_Light_Gray 212R/212G/212B 12

itg_Metallic_Pewter 98R/94G/87B 13

itg_Gunmetal_Blue 72R/84G/88B 14

itg_Light_Blue 115R/196G/207B 15
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Taking Your Screenshots
The following information provides the guidelines for capturing your 
screenshots.

Due to multiple user interface designs within the product, different techniques 
are used for capturing the various window components of the Dashboard and 
the Workbench.

Also, do not be concerned about resizing (scaling) since this will be 
accomplished when importing the screenshots into FrameMaker. This ensures 
that the artwork reflects the user experience.

Capturing the Dashboard
The Dashboard, as well as basic browser pages, can be captured using the 
following techniques.

Context Screenshots
For screenshots that are to provide context and level-setting:

Maximize the Dashboard window.

Do not change the size of any other window.

In HyperSnap, make sure that:

Auto Scroll Window is enabled and used for windows that exceed the 
vertical size of the screen

Include Cursor Image is disabled (unless there is a compelling reason to 
include the cursor)

Take the screenshot of the desired area using Capture > Window making 
sure that the window does not include the browser taskbar.

Save your screenshot as a GIF file in the appropriate art folder.

Do not change any of the settings on the Production Lab system.
If you need help or clarification, feel free to contact Steve or Donna.
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Example

Figure 2-2. Dashboard context (width between 715 and 1024 pixels)
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Detail Screenshots
For screenshots that are to provide enhanced detail:

Maximize the Dashboard window.

Do not change the size of any other window.

In HyperSnap, make sure that:

Auto Scroll Window is enabled and used for windows that exceed the 
vertical size of the screen

Include Cursor Image is disabled (unless there is a compelling reason to 
include the cursor)

Take screen shots using Capture > Region.

Using HyperSnap, crop the image as desired.

Save your screenshot as a GIF file in the appropriate art folder.

Examples

Figure 2-3. Dashboard detail (width between 406 and 714 pixels)
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Figure 2-4. Dashboard detail (width between 497 and 405 pixels)

Figure 2-5. Dashboard detail (width less than 97 pixels)
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Capturing the Workbench
The Workbench can be captured using the following techniques.

Context Screenshots
For screenshots that are to provide context and level-setting:

Maximize the window containing the shortcut bar and Workbench 
window.

Do not maximize the Workbench window.

Do not change the size of any other window.

If necessary, move the Workbench window into the upper-left corner of the 
blue workspace.

In HyperSnap, make sure that:

Include Cursor Image is disabled (unless there is a compelling reason to 
include the cursor)

Take the screenshot of the desired area using Capture > Region.

Using HyperSnap, crop the image so that the:

Right edge of the Workbench window forms the right boundary

Left edge of the shortcut bar forms the left boundary

Top edge of the Workbench menu forms the top boundary

Bottom of the “meaningful” shortcut bar area forms the bottom 
boundary

Save your screenshot as a GIF file in the appropriate art folder.
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Example

Figure 2-6. Workbench context (width between 715 and 1024 pixels)

Detail Screenshots of Workbench Windows

For screenshots that are to provide enhanced detail:

Maximize the window containing the menu bar and Workbench.

Do not maximize the Workbench window.

Do not change the size of any other window.

In HyperSnap, make sure that:

Include Cursor Image is disabled (unless there is a compelling reason to 
include the cursor)

Take the screenshot of the desired area using Capture > Region.

Using HyperSnap, crop the image as desired.

Save your screenshot as a GIF file in the appropriate art folder.

The Workbench window is currently identified by the Mercury Interactive logo.
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Detail Screenshots of Workbench Windoids

For screenshots that are to provide enhanced detail:

Maximize the window containing the menu bar and Workbench.

Do not maximize the Workbench window.

Do not change the size of any other window.

In HyperSnap, make sure that:

Include Cursor Image is disabled (unless there is a compelling reason to 
include the cursor)

Take the screenshot of the desired area using Capture > Active Region.

Using HyperSnap, crop the image as desired.

Save your screenshot as a GIF file in the appropriate art folder.

The Workbench windoid is currently identified by the Java coffee cup logo.
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Examples

Figure 2-7. Workbench detail (width between 406 and 714 pixels)
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Figure 2-8. Workbench detail (width between 97 and 405 pixels)

Figure 2-9. Workbench detail (width smaller than 97 pixels)
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Visio Tips and Tricks
A template has been created to help you work with Visio. This template is 
available from StarTeam at n:\Kintana\Manuals\docs\
60PlanningPrototypes\Template\TemplateVisio.vsd.

For your convenience, this template includes color swatches and, incidentally, 
is the source file for Figure 2-1 on page 34.

To create a new graphic:

1. Either:

a. Open the template and delete the color swatches.

Or:

b. Open a new document in Visio and create a custom sized page using 
File > Page Setup.

Set the custom page size to be 5.25 inches by 8.0 inches. (This helps 
make sure that you design to the available space in the FrameMaker 
document.)

2. Create your diagram.

3. Add the ITG custom colors:

When using the template the ITG custom colors are not readily 
available from the menu bar. Therefore, you need to:
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c. Select your object.

d. To access the color selector:

For shapes, use right-click > Format > Fill > Fill Color.

For text, use right-click > Format Text > Font Color.

e. Click the desired color. The ITG custom colors are identified by color 
numbers 8 through 15 (as shown in Table 2-1 on page 34 and displayed 
in Figure 2-1 on page 34).

Or if you are not using the template:

f. Select your object and create the custom color using the RGB values 
shown in Table 2-1 on page 34.

4. Once your diagram is complete:

g. Save the diagram as a Visio file in the appropriate art folder.

h. Select all the diagram components using Edit > Select All.

i. Save your diagram as a GIF file in the appropriate art folder.

Set the resolution to 96 dpi by 96 dpi. Also set the size to match that of 
the diagram (automatically displayed in the Custom text box within the 
Size field.)

If you are creating multiple diagrams in the same Visio session, you may need to 
enable the Screen, Printer, or Source radio button in the Size field before selecting 
the Custom text box. The values displayed there may reflect the dimensions of the 
previous diagram.
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5. Close Visio if you do not want to create any new diagrams.
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Working with Artwork in FrameMaker
In general, when importing artwork into FrameMaker, the procedure described 
in the following section should be followed. However, there are some cases 
where deviations are expected. These include:

Importing multiple screenshots into a single anchored frame.

Including multiple figures within a single task or procedure.

Importing a screen shot that is to be annotated outside of its boundaries (for 
example, using call outs).

In the first two circumstances, you should import all the screenshots using the 
same dpi setting in step d of step 4 on page 48. This will ensure that the 
relative size of all the screenshots reflects the user experience.

In the last case, you should import the screenshot using the next smaller dpi 
setting in step d of step 4 on page 48. In rare cases, you may need to further 
reduce the dpi setting.

It may require some experimentation to determine a suitable dpi setting for all the 
artwork involved when there are deviations.
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Importing Your Artwork
From your FrameMaker file:

1. Insert an “empty” paragraph tagged as Figure/Table (Before/After) where 
you would like the artwork to appear.

2. Insert an anchored frame in this paragraph using 
Special > Anchored Frame > New Frame.

Set the Anchoring Position to Below Current Line, Alignment to Left, and the 
Width to 5.25 inches. Do not enable Cropped or Floating. Select the Height 
of your choice.

3. Select the anchored frame.

4. Include the desired artwork using File > Import > File.

a. Make sure that Import By Reference is enabled.

b. Navigate to the desired artwork. (This should be in the document’s 
corresponding art folder.)

c. Click OK.
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d. From the subsequent Imported Graphic Scaling dialog box, specify the 
Custom dpi using the image width information displayed in that dialog 
box in conjunction with the following table.

e. Click Set

5. If the artwork exceeds the vertical size of the anchored frame, select the 
anchored frame, then drag the bottom of the frame downwards. Adjust the 

Remember to allow for any of the deviations discussed in Importing Your Artwork.

Width (in pixels) Custom dpi

Browser

715 to 1024 195

406 to 714 162

97 to 405 129

1 to 96 96

Visio Graphic

1 to 504 96

Illustrator Graphic
(from Jeremy or Mandy)

1 to 788 150
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location of the artwork, within the anchored frame, until it fits (in its 
entirety) within the anchored frame.

6. If the anchored frame includes multiple imported screenshots, remember to 
select and use one dpi setting for all the imported screenshots. Then:

f. Arrange the screenshots as desired.

g. Once all screenshots are imported and arranged, select all the items 
within the anchored frame and group them using Graphics > Group.

7. If the artwork is to be annotated, review and follow the guidelines 
described in Annotating Your Screenshots on page 51 before proceeding to 
the next step.

8. Select the artwork.

h. View the Object Properties (right-click > Object Properties).

i. Set the value for both Offset From: Top and Offset From: Left to zero.

j. Note the values for Unrotated Size: Width and Unrotated Size: Height.

k. Click Set.

9. Select the anchored frame containing the artwork.

l. View the Object Properties (right-click > Object Properties).

m. Set the value for Unrotated Size: Width to that noted in the previous 
step j.

n. Set the value for Unrotated Size: Height to one-tenth of an inch more 
than the value noted in the previous step j.

o. Click Set.

10. If the artwork appears in a task step, insert an ‘empty’ paragraph tagged as 
Figure/Table (Before/After) following the paragraph containing the 
anchored frame.

This step is particularly important for the artwork appearing in the HTML documents.
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Otherwise, insert a paragraph with one of the following paragraph tags and 
title the artwork appropriately:

FigureTitle

FigureTitleWide

FigureTitle (Appendix)

FigureTitleWide (Appendix)

Annotating Your Screenshots
Should you need to annotate the screenshots to highlight details:

Use:

Rounded rectangles to identify common areas. 

The color for this is black and the size of the line is 3.0 points.

If absolutely necessary, identify specific items with call outs. 

Use black lines having no arrowheads. The line size should be 1.5 
points.

For text, use the Call out character tag.

Once all annotations are complete, select all the items within the anchored 
frame and group them using Graphics > Group.
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Verifying the Formatting
A few items require verification before final production of your document.

Ensure the following:

The anchored frame does not extend into the side head of your text area.

A Figure/Table (Before/After) paragraph precedes each anchored frame 
and that the paragraph contains only the anchored frame text symbol (an 
upside-down, uppercase letter T).

Either:

For artwork in a task step, a Figure/Table (Before/After) paragraph 
follows each anchored frame and that no text (or other text symbols) 
appears in the paragraph. (The paragraph should be ‘empty.’)

A figure title follows the anchored frame and uses one of the following 
paragraph tags:

FigureTitle

FigureTitleWide

FigureTitle (Appendix)

FigureTitleWide (Appendix)
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Process

In This Chapter:

Product Development Process
Document Authoring Process
Document Review Process
Document Editing Process

Developmental Edits
Copy Edits

Review/Production Checklist
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Product Development Process
<<Include a high-level view (from the TechPubs perspective) of the product 
development process.>>
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Document Authoring Process
<<Need to include (here or in the text chapter):

FrameMaker information

StarTeam information

FrameMaker file directory structure

File names

Graphics directory (named “art”)

Graphics filenames

Color guidelines

Code examples

Bulleted lists (bullets and hollow bullets)

Pronoun usage

Writing procedures

Writing process overviews>>
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Document Review Process
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Document Editing Process

Developmental Edits

Copy Edits
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Review/Production Checklist
Table 3-1 contains the review/production checklist.

Table 3-1. Review/production checklist (page 1 of 3)

Category, Item Complete

General, Text

Do a spellcheck of the entire book. (You may want to delete the existing dictionary.)

Update index entries for the entire book, if required.

Check Chapter 1, Text, on page 5 for the following kinds of issues:
Major sections of a document issues (particularly Introduction chapter issues)
Style, paragraph and font issues
Word usage violations
Capitalization violations (especially entity names, which should not be capitalized)

Search for capitalization inconsistency (for example, search for both Interface and 
interface).

Check the index for capitalization problems, consolidation problems, misspellings, etc.

Remove notes to reviewers (search for << and >>, AuthNote items, and SMENote 
items).

Search for Kintana, Accelerator, Drive, Deliver, 50, 5.0, 55, 5.5, suite, solution, O*M, 
GL*M, and other terms obsolete since the prior release(s).

Change Mercury Interactive to Mercury (except in on the copyright page), ITG to IT 
Governance, Center Workbench to Workbench, Center Dashboard to Dashboard, 
Center Server to Server, Release to release, seeded to Mercury-supplied, book to 
document, template to module, and click on to click.

Check for correct use of trademarks and registered trademarks. In particular, be sure to 
add the trademark symbol for first mention of each Mercury IT Governance Center 
application discussed in the document. <<Steve, do we have a current complete list 
from Legal?>>

Check the accuracies of all URLs listed. Also be sure that they are hyperlinked and that 
the hyperlink works.

Check the appearance and accuracy of all procedures.

Check all cross-references (within the document) for relevance.

Check all references to other documents in the Documentation set. Are the titles 
accurate? Is the information you’re pointing to really in the document? Are the book 
titles in italics?
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Template, FrameMaker

Did you use the most up-to-date FrameMaker template?

Remove all deprecated tags.

Update (run) the entire book in FrameMaker and correct any problems (for example, 
unresolved cross-references).

Remove all change bars.

Check page numbering (title is Roman; TOC, List of Figures, and List of Tables are 
Roman and continue; chapter 1 is numeric and continues; all other chapters are 
numeric and continue; Index is numeric and continues).
Be sure page numbering is not reset to 1 in the Introduction chapter. One reason we 
use continuous numbering is so the Adobe Reader page number identifier is the same 
as the number on the actual document page.
You may need to manually set the first page of the Introduction chapter to get the 
numbering to be contiguous. You’ll also have to monitor this page number throughout 
the document development process; it may need to be manually reset as TOCs, LOFs, 
and LOTs expand or contract in size.

Check headers and footers. (Do not edit-check variables or headers.)

Check the title page, TOC, List of Figures, List of Tables, part, chapter, appendix, and 
index files.

Check the mini-TOC at the beginning of each chapter.

Page through the entire book (from front to back) and fix widows and orphans.

Check for table problems, including incorrect titles and incorrect use of Figure/Table 
(Before/After).
Be sure all tables have either a “continuation” or “sheet x of y” variable. (See Table 1-1 
on page 9 for information about when to use which.)

Check all xrefs (chapters, sections, tables, figures). Be sure use of “on page x” 
references are used correctly.

Check for bad word or phrase breaks (especially those containing hyphens) and insert 
non-breaking spaces or, if necessary, forced line breaks.

Table 3-1. Review/production checklist (page 2 of 3)

Category, Item Complete
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Graphics

Check the quality of all graphics.

Review the colors and tags in artwork and callouts.

Make sure the anchored frames are sized to the artwork.

Be sure all screenshots were taken in the final 6.0 product.

Be sure all screenshots show only appropriate data.

WebWorks

Mark mini-TOC (and x.Rule paragraphs, x.InThisChapter or x.InThisAppendix) as 
PrintOnly conditional text. Also disable the condition indicator.

Add a TopicAlias marker (and the text Introduction) before the Introduction chapter 
name.

Search for red Courier text and fix FrameMaker style problems showing up in 
WebWorks.

Correct any WebWorks production problems.

Final Production

Be sure all the graphics (in GIF format) are in the art directory. Delete all graphics no 
longer used.

Check the final files (book and art) into StarTeam with an appropriate label (entered as 
a comment) — for example, “final 6.0 version.”

Table 3-1. Review/production checklist (page 3 of 3)

Category, Item Complete
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Release 6.0 Production Procedure

for Authors

In This Chapter:

Prerequisites
Requirements
Highly Desired
Requested

Getting Your Document Into a Build
Assessing the Evaluation Site Results

For the HTML Version of Your Document
For the PDF Version of Your Document

Assessing the Product Results
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Prerequisites
As you produce drafts and especially prior to final document production, 
evaluate your documents to ensure that what you expect is being created by the 
production tools and processes.

There are a number of assessments and actions that should be completed prior 
to any checkin (either for evaluation purposes or of a final document).

Requirements
StarTeam folder contains only the book file and the FrameMaker files 
included in the book.

None of the aforementioned files are locked.

Remove all FrameMaker backup files from StarTeam.

There are no unresolved cross-references in your book.

There is no unresolved artwork. (Placeholders are OK until early January.)

Notification to Donna of any changes in book structure. For example, 
renaming, removing, adding, or reorganizing a FrameMaker file within the 
book.

All deprecated styles have been removed.

TopicAlias marker has been added to first chapter (usually Introduction). 
(Applies to all documents even those not deployed as HTML.)

The mini-TOCs are conditionalized as PrintOnly. (Applies to all 
documents even those not deployed as HTML.)
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Highly Desired
All review/production checklist items, listed in the Documentation Style 
and Process Guide, have been completed.

Document is at current template release level.

Art folder contains only the artwork used in the document.

Requested
Notification of the status of screenshots and graphics. For example, all 
screenshots are final and there is one more graphic to be completed and 
incorporated.

After early January, these become requirements.
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Getting Your Document Into a Build
To get your updated document into the next build of the Evaluation site and/or 
staged for the next product build, notify Donna via email that the files are 
ready to be updated. Please include the StarTeam path to the document.

Once Donna receives your email:

The files will be locked as soon as possible.

The files will be copied to the Production Staging site in preparation for 
updating the builds.

The files will be unlocked and you will be notified that the files have been 
released for your use.

Between now and early January, indicate if the book should be updated on the 
Evaluation Site only.

Assessing the Evaluation Site Results
Watch for the announcement from Donna that the Evaluation Site has been 
updated. If the logfile from AutoPDF has been included with the message, 
review that and remove any un-necessary cross-references from your 
documents.

Then carefully review your document as described in the following sections. If 
you have any questions or concerns, ask Donna for assistance.

For the HTML Version of Your Document
Make sure that the document opens to the first page of the Introduction 
chapter. If this does not work, check that the TopicAlias marker is correctly 
set in your FrameMaker file.

Confirm that the document does not open in a new window.

Verify that the Contents frame expands and highlights the title of your 
document. If this does not work, check that the TopicAlias marker is 
correctly set in your FrameMaker file.
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Make sure that the document, including chapters, appendices, 
cross-references, hyperlinks, table of contents (Contents tab), and index 
(Index tab) correspond to your intent and expectations.

Confirm that there are no mini-TOCs at the beginning of each chapter. If 
any mini-TOCs exist, conditionalize them to PrintOnly in your 
FrameMaker file and remember to deselect Show Condition indicators.

Text shown in red typeface indicates that there is a template style violation. 
Review your FrameMaker file and make sure that these are corrected.

Once all problems are corrected, re-submit the document for production.

For the PDF Version of Your Document
Make sure that the document, including cross-references, hyperlinks, table 
of contents, and index correspond to your intent and expectations.

Verify that the document opens, in Adobe Reader, to the title page.

Confirm that the document does not open in a new window.

Ensure that the Documentation Home Page link (in the bookmarks) returns 
you to the Documentation Home Page.

Make sure that the mini-TOCs appear and are not in green or red text.

There is one known problem with the WebWorks translation from FrameMaker into 
HTML.

The first table (other than Note or Warning) in any chapter will have its first text 
shown in red.
For BasicA tables, this red text appears in the title. For BasicB tables, the red text 
appears in the first table cell.
If your first table in a chapter does not have any red text, that may also indicate a 
problem. This is usually attributed to the use of a table format that is not in the 
template.

There is a workaround for this matter and it will be implemented during the final 
production run.
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Assessing the Product Results
Monitor the Smoke instance of the N2 testing sites.

Once the Smoke instance has been updated with the most recent build, review 
the document there. Make sure that this version of the document is as expected. 
If not, contact Donna.

When time permits, review the documentation using Internet Explorer (version 
6.0 or later).
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A
Importing Excel Data

To import data from an Excel spreadsheet into FrameMaker:

1. Open the Excel file.

2. Using Save As, save the file as a Text (tab delimited) (*.txt) file.

3. Close the Excel file.

4. Open the newly created text file using Notepad.

5. Select all the text.

6. Copy the text (to the Windows clipboard).

7. Close the text file.

8. Open your FrameMaker file.

9. Position your cursor where you want the data (table) to appear.

You may want to insert some placeholder empty paragraphs around this location.
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10. Paste the data (from the Windows clipboard).

11. Select all the spreadsheet data.

12. Using Table > Convert to Table, convert the data back into a table that 
mimics the Excel spreadsheet.

Some things to consider about the conversion:

Table Format. Do you want a title for the table? If yes, select BasicA. 
If not, use Basic B.

Table Header.

Do you want to include a header for the table and is the information 
for the header included in your data? If yes, use the settings shown 
in Figure A-1.

Figure A-1. Include a header with existing data

Do you want to include a header for the table and you do not have 
the information in your spreadsheet data? If yes, use the settings 
shown in Figure A-2. 
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Figure A-2. Include a header and add new heading information

If you do not want any header, use the settings shown in 
Figure A-3.

Figure A-3. Do not include a header

13. Verify that the data mimics your Excel spreadsheet.

14. Remove any blank paragraphs that you may have inserted to help bracket 
the imported data.

15. Save your FrameMaker file.

16. Close the FrameMaker file (optional).

17. Delete the intermediate text file (optional).
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